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Learning Outcomes
• Annual Budget Development at CPP

• General Navigation

• FY2025/26 Budget Development Deadlines

• Building Operating Budget

• Submitting Operating Budget

• Questions?
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Annual Budget Development at CPP
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• Budget Assumptions & Strategies
• Building your annual budget has not changed.

• Goal of budget planning is to create a balanced and sustainable ongoing budget that 
supports the University’s strategic plan, mission, and vision.

• An all-funds budgeting approach provides an enterprise-wide view of fiscal resources 
and ensures resource allocation decisions are made with an understanding of all 
available funding sources and uses.

• Easier to fully build your budget up-front than make mid-year changes.
• Enrollment: 22,688 Resident FTES

• CY Headcount: 26,810 plus 3,001 for Self-Support
• Fees: build in contingency in enrollment 

• Re-consider investments that will trigger recurring expenses. 
• Use existing resources, i.e. software, or identify less expensive alternatives.
• Use Quarterly Report projection for year-end available balance for carry-forward allocation.
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Building Annual Operating Budget in Questica
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• Funds
• All State Oper Funds (SOF)

• POM01 (General Fund Allocation) 
• Lottery

• TY006 – Educational Access Academic Development
• TY017 – California Pre Doctoral
• TY033 – General Campus Based Programs

• Cost Recovery
• PCR01 – Internal Sources
• PCR02 – External Sources
• PCR04 – Academic Facility Space Rental
• PCR05 – Theatre Space Rental
• PCR06 – Film & Photo Shoot Space Rental
• PCR07 – Capital Project Management
• PCR10 – AB 798 Textbook Affordability

• Trusts
• TX130 – Lanterman (Administrative Affairs)
• TX140 – Edu Access Academic Development (Academic Affairs)
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Building Annual Operating Budget in Questica
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• Funds Continued
• All State Oper Funds (SOF) Continued

• State Grants
• POS01 – CSUPERB Grant
• POS02 – COAST Grant
• POS03 – AG Research Institute
• POS04 – WR&PI Grant
• POS05 – RSCA Awards Program
• POS06 – STEM NET Mini Grant
• SP003 – Sup Agric Research Ins IPM Program
• SP004 – College Student Right to Access Program
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Building Annual Operating Budget in Questica
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• Funds Continued
• Auxiliary Enterprises (Spending Plans)

• College of Professional and Global Education
• TM001 – TF PaCE-Expenditure
• TM002 – TF PaCE-Campus Partners
• TM500 – TF PaCE-Special Summer
• TM502 – TF PaCE-Special Winter

• Housing
• TZ001 – Housing-Operations and Revenue

• Parking & Rideshare
• TV002 – Parking Fines/Forfeitures Exp
• TW001 – TF PRF-Expenditures
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• Cost Recovery Budgeting
• Annual budget allocation is tied to recurring revenue.

• PCR01 – Plan for 80% of FY24/25 revenue posted.
• PCR02 – Plan for positions tied to approved MOUs, etc.

• Examples: approved positions to be fully or partially funded by the Philanthropic Foundation, 
grants, cost recovery plans with Auxiliary Enterprise entities, etc. 

• Carryfoward: Use projected year-end balances.
• Budget is posted at the beginning of the year and reconciled twice in March and June.

Building Annual Operating Budget in Questica

 All State Oper Funds (SOF)  Auxiliary Enterprises         Both  
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• Financial Data
• Revenue/Allocation

• Enrollment Projections (Auxiliary Enterprises) 
• Annual Budget Allocation Memo (All State Oper Funds (SOF) )

• Personnel (Positions)
• Tableau HR Actuals Dashboard
• Position Salary Information

• Operations (GL Account Level)
• Tableau Finance Dashboard

• Prior Year Actuals
• OE&E Exercise

• Purchase Orders – Past & Future

Building Annual Operating Budget in Questica

https://analytics.cpp.edu/#/site/production/workbooks/1361/views
https://analytics.cpp.edu/#/site/production/workbooks/135/views
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• Position Management Stages
• During annual budget development, divisions determine how they plan to fund positions in 

Questica using Positions and Position Allocations entities.  The initial budget submitted 
becomes the adopted budget.

• Once a budget is submitted, we go into the maintenance phase, where changes to the position 
listing must be processed as transfers that net to zero.  Position budget adjustments submitted 
outside of the annual budget stage are called off-cycle adjustments.  The process is very similar 
to how we manage our General Operating Fund.

• Operation Budgets
• Once the department’s annual budget has been established, it is not necessary to zero-out 

deficits by account (CFS).
• Total operating budget must not result in a deficit; must remain in the “black.”

Building Annual Operating Budget in Questica

 All State Oper Funds (SOF)  Auxiliary Enterprises         Both  
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• Position Management Principles

Building Annual Operating Budget in Questica

• When allocating General Fund (POM01), 
base-fund permanent positions whenever 
possible.

• Align funding type with permanent or 
temporary positions.

• Will need to budget for benefits except 
for Undesignated and Designated 
POM01-funded positions, which are 
managed centrally by BP&A.

               All State Oper Funds (SOF) 

• If a new position has been created in PS 
and needs be added into Questica, 
please reach out to Debbie Chavez 
(debrachavez@cpp.edu).

• There should only be one template 
(holding) position for salary savings for 
each division, which should be in the 
VP’s Office. There should not be FTE 
tied to these positions. 

• If you have plans to fill a position in the 
future, place the funding and FTE in an 
existing position.

  Both

mailto:debrachavez@cpp.edu
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General Navigation

12
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General Navigation Focus Points
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I. Menu & Sub Menu Options

II. Menu Icons

III.Grid / Screen Features

User Log In – Sandbox 
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Main Menu Menu Ribbon Icons
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Menu Ribbon Icons
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Questica Search Feature -
Current screen

Batch Processes – export/import of 
grid lines and reports, approvals & 
publishing & export of reports

Budget Calendar

Bookmark – screens, change 
requests

Notifications – @-mentions

User Name – Profile 
Settings & Sign Off
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4 Menu Options

16

1. Dashboard - Dashboards display information with visualizations, (charts, graphs, reports and counters) 
on one screen. A dashboard’s intent is to summarize information to keep users up to date on what’s 
happening and indicate whether action is required.

2. My Tasks - Identifies items a Questica Budget user is responsible for and lists them on the My 
Tasks page. It is an easy and simple way for Users to find and open their work when logged into the
system. A notification badge lets you know when new tasks have been assigned. The system manages the 
items by date and security settings.

3. Budgeting - Contains 7 sub menus of which 3 will be frequently used by campus users. Operating, 
Personnel, and Change Request sub-menus

4. Reports - The Report Center displays a list of all available Print Reports, Smart Reports and Views. The 
Report Center provides several ways to find and run new Reports, as well as bookmark your favorite ones.
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1. Questica Dashboard

Smart Report
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1. Questica Dashboard

Smart ReportChanging Dashboard View
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1. Questica Dashboard

Smart Report
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2. My Tasks
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Entities for Entering Annual Budget 
Data
• Budget Lines (O/E)
• Position Allocations
• Positions

STAGE 1 of Workflow Process – 
INPUT & PROMOTE

3. Questica Budgeting Menu

Entity for Publishing Annual 
Budget Data
• Positions

Entities for Promoting Annual Budget 
Data
• Fund-Department 
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3. Questica Budgeting Menu

Entities for Promoting Annual Budget 
Data
• Fund-Department 
• Account Summary

Entity for Publishing Annual 
Budget Data
• Positions

STAGE 2 of Workflow Process - 
REVIEW
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3. Budgeting > Position Entity

NOTE:

Select the proper FY
Select LOAD DATA

Fiscal Year for Annual 
Budget should ALWAYS BE 
UPCOMING FY – NOT CURRENT 
WORKING FY

Entities Affected
Positions
Position Allocation
Budget Lines
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3. Budgeting > Position Allocation
NOTE:

Select the proper FY
Select LOAD DATA

Fiscal Year for Annual 
Budget should ALWAYS BE 
UPCOMING FY – NOT CURRENT 
WORKING FY

Entities Affected
Positions
Position Allocation
Budget Lines



2525

3. Budgeting > Budget Lines

NOTE:

Select the proper FY
Select LOAD DATA

Fiscal Year for Annual 
Budget should ALWAYS BE 
UPCOMING FY – NOT CURRENT 
WORKING FY

Entities Affected
Positions
Position Allocation
Budget Lines
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4. Reports

1. Reports > Adhoc Views 

2. Search Bar : Use to Search for Report- enter Report Name
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Features within Questica Grids

• Group By
• Freeze
• Resize to Content
• Fit on one screen

GRID FEATURES

SEARCH BAR

SORTING

COLUMN FORMATTING
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Grid Features : Add

Adding a Row

1. Select the Green + sign

2. Enter Data using the 
Tab Key to move within 
cells

3. Press Enter to Save
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Grid Features : Add
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Grid Features : Value Bar

Value Bar

1. Shows the contents of 
the currently selected 
cell in a much wider 
area for improved 
readability and 
supports editing of 
most data types.

2. Used for identifying 
formulas
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Grid Features : Filter
Filter

1. The Filter bar can 
be toggled on/off by 
clicking the Filter 
button on the 
toolbar

2. When ON a row will 
appear under each 
column header. You 
can then search for 
specific characters 
of numbers by using 
the specific column 
fields.
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Grid Features : Layout

Layout

1. Allows change to 
the grid display 
by adding or 
removing column 
fields, grouping 
and defaulting 
grid options 
(value and filters)
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Grid Features : Layout



3434

Grid Features : Import/Export

Import/Export
1. Export the 

contents of grids 
to an Excel 
spreadsheet. 

2. Edit the data and 
import it back 
into Questica to 
update data 
efficiently.



3535

Search Bar

1. Dependent on 
the Active 
Grid/Screen. 

2. Advanced 
Search option 
<Query> 
available.
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Sort Feature within a Grid

Sort
1. Click on a column 

header and the grid 
will sort in 
ascending order by 
that column. 

2. Click again, and the 
column will sort in 
the reverse order. 

3. Click a third time to 
remove the sort.
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Column Formatting : Group By
Right Click on desired column heading to enable Group By

• Home Fund Group by – Fund Column
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Column Formatting : Freeze (Column Scroll)
Right Click on desired column heading to enable Freeze

• Name column
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Column Formatting : Resize to Content
Right Click on desired column heading to enable
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Column Formatting : Fit on One Screen
Right Click on desired column heading to enable
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Fiscal Year Comparison Feature

•Entities
with comparison
feature :

• Account Summary
• Budget Lines
• Position Allocation
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FY2025/26 Budget 
Development 

Deadlines

42
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• Preliminary Submission: July 10th

• Summary of the Budget Validation Ad Hoc View (report)
• Tentative Final Submission: August 15th 

• VP Signed PDF of a summary of the Budget Validation Ad Hoc View (report)
• Promotion of the Operating Budget via Questica

FY2025/26 Budget Development Deadlines

• Please email all of the submissions to the applicable BP&A Analyst that supports your area.
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Building Annual Operating Budget in Questica

45

• Key Entities
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Building Annual Operating Budget in Questica
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• Position Management
• Home DeptID vs Charge DeptID

• Home DeptID – where the position lives.
• Charge DeptID – the department that is charged for the expense.

• Funding at the Position Level
• Staff, Faculty (T/TT & Temp), and MPP

• Unions: R02, R03 (except 2403), R04, R05, R06, R07, R08, R09, M80, & M98
• Funding Positions via General Ledger (GL) not at the Position Level

• Union Code: R11 and E99
• Student/Graduate Assistants: 601103, 601303, 602001, 602002, & 602004
• Teaching Associates: 601304
• Overtime: 601301
• Substitute Faculty: 601805
• Stipends (2403, etc): 601810, 601814, 601815, 601816, 601819, & 601820
• Unallocated Compensation (No FTE): 601802
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• Position Management Continued
• Compare Active Positions (Tableau HR Actuals) to Position Funding Plan
• PeopleSoft HR (PS-HR) Position Inactivation – After the annual budget load (Oct/Nov)

• Provide a list of positions to inactivate in PS-HR effective with the 25/26FY to your 
BP&A PoC

• Refer to Tableau HR Actuals dashboard to identify active positions.

Building Annual Operating Budget in Questica



48

Building Annual Operating Budget in Questica
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• Notes 
• In various screens, notes can be sent to users.

• Select the Note icon
• Upper left of the screen or in the applicable row

• Type “@” in front of the person’s name to select 
the recipient of your note.

• Type your note and then select “Post”
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Building Annual Operating Budget in Questica
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• Positions Entity
• Establishes the Position’s FTE & Annual Budget per FTE
• Select the applicable Fiscal Year and select Load the Data
• Select Layout: Annual PSN Budget Build
• Filter: Budgeted Positions vs Unbudgeted Positions

• Filter: Do not include
• Unions: E99 and R11
• Job Code: 2403

• Export the Positions into an Excel File
• Tip! Save two versions

• One to use as a reference and the other to make your edits.
• Triple check position budget plans before deleting rows.
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Building Annual Operating Budget in Questica
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• Positions Entity Continued

•  Creating a Filter
• Select

• Add criteria by clicking 
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Building Annual Operating Budget in Questica
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• Positions Entity Continued
• Unhide Column A
• Select A2 through L2 to enable filters on the column headers

• It is critical that column A is visible if filtering the data in the file 
• Column A is the unique key for the position.

• Update data in columns H – L
• Position Type, Position Status, Paid Hours, and Annual Budget per FTE

• Start Date is data from PeopleSoft-HR (new positions should have a July 1st start date)
• Constant Fields:

• Cost Position Using = “Salary”   FTE Definition = “2,080”
    Position Security Group = “Applicable Code” (see next slide)
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Building Annual Operating Budget in Questica
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• Positions Entity Continued
• Position Security Groups

• Divisions
• PRES - President’s Office
• ACAD - Academic Affairs
• ADMN - Administrative Affairs

• UPD – University Police Department
• ITIP - Information Technology & Institutional Research
• STAF - Student Affairs
• UADV - University Advancement

• Auxiliary Enterprises
• CPGE - College of Professional and Global Education
• HSNG - University Housing
• PRKG - Parking and Transportation Services
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Building Annual Operating Budget in Questica
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• Positions Entity Continued
• Make changes

• Double-Click in applicable Field(s) for Quick Updates in Questica
• Export for Mass Updates

• Complete Data Validation
• Data>Data Tools>Data Validation>Circle Invalid Data
• Correct any cells that have a red circle

• Save and Close the exported Excel File.
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Building Annual Operating Budget in Questica
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• Positions Entity Continued
• Import edited Excel file

• Select Import > Positions > Select File > Click OK
• Files can only be imported once.
• Export the data again if additional changes need to 

be made.
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Building Annual Operating Budget in Questica
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• Positions Entity Continued
• Validate the Data

• After the file has successfully been imported, reopen the file and total the Paid 
Hours and Annual Budget per FTE columns.

• Compare Totals for Paid Hours and Annual Budget per FTE
• If additional changes need to be made, run a new export, update data, save, & import the file.
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Building Annual Operating Budget in Questica
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• Position Allocations
• Establishes the position’s funding source
• Select “Position Allocation Annual Budget Dev” Layout
• Export and Unhide Column A
• Select A2 through R2 to enable filters on the column headers

• It is critical that column A is visible if filtering the data in the file 
• Column A is the unique key for the position.

• Update the following fields based on the divisional budget plan:
• Budget Scenario, Fund-Department, Program, Class, Account, and Amount

• To make mass changes, Export, Update, Save, Close and Import the file.
• To make quick changes in Questica, double-click on the field, update, and 

  click outside the field.
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Building Annual Operating Budget in Questica
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• Position Allocations Continued
• Sync’d Fields via PeopleSoft

• Position Number, Position, Start Date, and Designations
• Designation field is populated by Questica based on the Class Code for POM01-Funded PSNs.
• The following fields will calculate based upon Paid Hours (Position Entity) & Amount (PSN Alloc.)

• Select “Position Allocation Review – Effective Values” layout to validate.
• Position FTE, Effective FTE, Effective Hours, & Effective Allocation Percentage

• Effective FTE: Position FTE * Amount * Duration
• Effective Hours: Paid Hours * Amount * Duration
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Building Annual Operating Budget in Questica
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• Position Entity Continued
• Position Publishing

• Option #1 - Click the top left box to select all of the positions or individual positions.
• Right click on the positions (highlighted/selected positions - blue section)

• Option #2 – Select the “Publish” button located in the top right

 



59

Building Annual Operating Budget in Questica
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• Position Entity Continued
• Position Publishing Continued

• Click “OK”
• Click Close once the status is Complete
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Building Annual Operating Budget in Questica
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• Position Entity Continued
• Position Publishing Continued

• Once positions have been published, budget lines are established for the budgets 
tied to the positions.

• The link image (on the left side under the lock) indicates that the budget is tied to 
positions.
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Building Annual Operating Budget in Questica
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• Position Funding Validation (Published Positions)
• “Position Budget Details V2 – Tableau Web API” file

• File is located in the SharePoint “Division” Folder 
• Divisions>2025-26>Annual Budget Dev>PSN Mgnt

• Data is linked to Questica. DO NOT CHANGE ANYTHING IN THE TABLE
• Can save a version of the file in your own Division SharePoint folder.

• Click “Refresh All” to sync the data. 
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Building Annual Operating Budget in Questica
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• Position Funding Validation Continued
• Tab 1 – Totals by Position regardless of Funding or Designation
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Building Annual Operating Budget in Questica
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• Position Funding Validation Continued
• Tab 2 – By Fund
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Building Annual Operating Budget in Questica
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• Position Funding Validation Continued
• Tab 3 – Totals for POM01 Base Funding by Designation
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Building Annual Operating Budget in Questica
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• Position Funding Validation Continued
• Tab 4 – Totals for POM01 One-Time Funding By Designation
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Building Annual Operating Budget in Questica
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• Budget Lines
• The Screenshot below only reflects budgets tied to positions.
• The next step is to add operation budgets
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Building Annual Operating Budget in Questica

67

• Budget Lines
• Types of Accounts

• Revenues (5XXXXX account codes)
• Credits are reflected as a positive number in Questica (negative number in Tableau)

• Expenses (6XXXXX account codes)
• Debits are reflected as a positive number in Questica (positive number in Tableau)

• Add Budget Lines
• Click “+ Add” to directly add or use the Export/Import option for mass updates
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Building Annual Operating Budget in Questica
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• Budget Lines
Add Budget Lines
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Building Annual Operating Budget in Questica
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• Budget Lines
• Adding Supporting Documents

• Individual Budget Line
• Click on the paperclip cell

• Select “+Add” and then select your files(s)
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Building Annual Operating Budget in Questica
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• Budget Lines
• Adding Supporting Documents Continued

• Fund-Department Level
• Go to applicable Fund-Department
• Select the paperclip image

• Select “+ Add” and then select “Select File”
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Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File
• Ad-Hoc Report: “CLL – Budget Load Validation”

• Budget Services SharePoint>Divisions>2025-26>Annual Budget Dev> Budget Validation
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Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File
• Ad-Hoc Report: “CLL – Budget Load Validation”
• Steps

• Go to Questica > Reports > Ad hoc Views (Report)
• Search for the Ad hoc report that you would like to connect to Excel
• Right Click on the name of the Ad hoc report
• Select “Connect to Excel”

• The info you need to make the connection in Excel will be displayed in a pop-up 
window.
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Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File Continued
• Go to Excel>Data>”Get & Transform Data”>”From Web”
• Enter the information from the “Connect to Excel” window into the Excel “From Web” window, 

then click “OK.” 



74

Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File Continued
• • A PowerQuery will pop up.

• Then click the upper left “To Table” button.
•  
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Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File Continued
• • Accept the table by clicking OK.

• Then click the expand button to load up all the columns then click “OK”.
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Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File Continued
• • The data should populate the screen.

• Then choose “Close & Load” (top option)..
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Building Annual Operating Budget in Questica
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• Validate Budget Load – Create Web API File Continued
• • Then Excel will load the Power Query to the first available blank sheet.

• All the columns in the Report View are reflected here

• To refresh the data go to “Data” and select “Refresh All”
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Submitting Operating 
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Submitting Operating Budget in Questica
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• Sample eMail Notifications
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Submitting Operating Budget in Questica Cont.
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• Position Budgets Hands-On Activity
Create a Notification for Budget Promotion/Demotion
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Submitting Operating Budget in Questica Cont.
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• Position Budgets Hands-On Activity
Create a Notification for Budget Promotion/Demotion Continued
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Submitting Operating Budget in Questica Cont.
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• Promoting Validated Budget to the Next Level
• Go to Fund-Department
• Click on the boxes of the Fund-Department(s) that you would like to promote (or demote)

• Right click and select Promote/Demote
• Make any notations in the comment box and then click okay
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Submitting Operating Budget in Questica Cont.
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• Promotion/Demotion of Budget Continued
• Budget Promotion Options

• Budget Preparer selects Management Review (Stage 2) for the Division Budget Officer 
to Approve.

• Division Budget Officer to select Final Approval (Stage 3) if budget is approved for BP&A 
Approval.
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Submitting Operating Budget in Questica Cont.
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• Promotion/Demotion of Budget Continued
• When promoting to BP&A (Stage 3), please note that the VP has 

approved the budget and that a PDF of the signed budget has 
been emailed to BP&A.

• eMail VP approved PDF of the budget to the applicable .
• Click Save

• Deadlines
• Preliminary Submission: July 10th

• Summary of the Budget Validation Ad Hoc View (report)
• Tentative Final Submission: August 15th 

• VP Signed PDF of a summary of the Budget Validation Ad Hoc 
View (report)

• Promotion of the Operating Budget via Questica
• Please email all of the submissions to the applicable BP&A 

Analyst that supports your area.
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Submitting Operating Budget in Questica Cont.
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• Promotion/Demotion of Budget Continued
• Management Review: Promote or Demote

• Promote – Follow previous steps
• Demote – Follow upcoming steps
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Submitting Operating Budget in Questica Cont.
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• Promotion/Demotion of Budget Continued
• Demotion of Budget

• Select “1-Budget Entry” to return the budget back to the preparer.
• Add comments for the preparer in the Notes
• Click Save
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Submitting Operating Budget in Questica Cont.
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• Once PB&A approves the Fund-Department Budget, the option to promote is 
no longer available.
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Questions?
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